WordPress Tutorial

Covers WordPress Multisite version 4
Hosted at UW-Madison Russell Labs
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How to Get Help

Email webeditor@russell.wisc.edu for questions about your WordPress site.

Quick Start

1. Log into WordPress

1. Open a web browser and enter the URL for your site followed by /wp-login.php
Example:
To log into a site named smith, type:
http://labs.russell.wisc.edu/smith/wp-login.php

The login window opens:

@ WORDPRESS.COM

Username
Password

[ remermber Me[:} Log In

Reqgister | Lost vour password?

Enter your username and password. These are not your email or NetID credentials. If you have problems email
webeditor@russell.wisc.edu.

Tip: Notice the Lost your password link on the image above — if you forget your password, you can click the link and
have WordPress generate a new password for you. WordPress emails the password to whatever email you
recorded in your Profile (see step 2).

2. The WordPress Dashboard opens:
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@ Dashboard

Home

Posts

Media
* Links

Pages

Comments

%

Appearance

3

Plugins

Users

v B

Tools

%]

Settings

(4]

.7,‘ A Mysites @& Brunetlab + New Howdy,
zlp
Dashboard
At a Glance WordPress News

W apages WordPress 4.0 Beta1 July 10, 2014
WordPress 3.9.1 running Twenty Eleven Child Theme for W

Brunet theme.

Storage Space

£33 150 MB Space Allowed B3 1.09 MB (1%) Space

Used
WPTavern: Nantes, France to Host a WordCamp for
Developers in November
Help
WPTavern: Blue Steel: A Free WordPress Theme Based
Welcome to your Russell Labs website! on Roots
Meed help? Check out: WPTavern: WordPress Mini Conference “East Meets
- our documentation page Press” Set For September 17-21, 2014

...0r contact Russell Labs IT.

Quick Draft

You are now in the WordPress administration screens, used to create and edit your site content.

2. Set Your Password and Name

Make sure to change your password the first time you login to your WordPress account.

1. On the left side of the Dashboard window is the Dashboard menu:

@ Dashboard

Home

Posts

Media
* Links

Pages

Comments

Appearance

Plugins

Users
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2. Click Users and choose Your Profile from the popup menu.
3. The Profile window appears.
4. Inthe Name section, enter your first and last names.

5. Inthe About Yourself section, locate the New Password box.

o

Click in the New Password box and enter a new password. The Strength indicator will show you if what you type is a
weak password. NEVER USE A PASSWORD WORDPRESS RATES AS WEAK.

7. Click Update Profile.

3. Create and Publish Your First Page
1. On the Dashboard menu, located and click Pages.

2. Choose Add New from the pop-up menu.

3. Ablank page appears:

creen Opfions Help

[] Add New Page

Publish

Save Draft Preview

Add Media Add Form Visual Status: Draft Edit
B I s U = i = Visibility: Public Edit
Font size v Format - @ ( = @ [#) Publish immediately Edit
B = M)
Move to Trash W
Fontfamily ~

Page Attributes

Parent

4. Click in the empty box below Add New Page.
5. Enter a title for the page — this will appear at the top of the page.
Note: Page names should be unique.

6. Click in the content box:

Creen Opuons. Help

[-] Add New Page
Publish

Save Drafl Preview

B Add Media | | [5] Add Form Visual Status: Draft Edit
B I = U & &= & === £ ERSE Visibiiity: Public Edit
Fontsze  + Format - QO 4dA-T-@ x x H = @ 4] Publish immediately Edit
B o & — Stles @
Move to Trash W
Fontfamily =

Page Attributes

Parent

content box

7. Type or paste text into the content box. If you copied text from Microsoft Word, do not paste directly into the
content box — click the Paste from Word button on the toolbar above the content box:
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8. Inthe Publish box to the right of the content box, click Publish.

4. Add Your New Page to the Website Menu

You have saved and published your new page, but you need to add a link to your site menu so visitors can find the page.
1. On the Dashboard menu, locate and click Appearance. Choose Menus from the popup menu.

2. The Edit Menus page appears:

Screen Options Help

|£| Edit Menus

Edit your menu below, or create a new menu.

Pages Menu Name  Menu 1 m

Menu Structure
Most Recent  View All Search
Drag each item into the order you prefer. Click the arrow on the right of the item to reveal additional configuration

[]Publications options.
[ People
[ Research Welcome
[] Welcome
People
Select Al Add to Menu
Publicati

3. Inthe Page box, click the checkbox next to the page you just created.
4. Click Add to Menu. A menu entry named after the page appears in the Menu box in the right column.

5. Click Save Menu.

Dashboard

The Dashboard is the control panel for your website. It’s the landing page you arrive at when you login to WordPress:
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Toolbar

i P Mysites @& Brunetlab BB + MNew

Dashboard @ Dashboard Dashboard
Menu

At a Glance

W 4 Pages

WordPress 3.9.1 running Twenty Eleven Child Theme for Brunet

theme,
Storage Space

07 150 MB Space Allowed ©37 1.09 MB (1%) Space Used

Comments Block

ocks
Help
Appearance

Welcome to your Russell Labs website!

¢ Plugins

Meed help? Check out:

Users - our documentation page
& Tools -..0r contact Russell Labs IT.
Wwiiia

Settings

Quick Draft

Dashboard Menu

The Dashboard menu appears on the left of all pages inside the WordPress Administration screens.

The menu provides quick links to create content (Pages) and customize your site (Appearance, Users, Tools and
Settings).

Toolbar

The toolbar is the black bar that runs across the top of the Dashboard. While you are logged into WordPress, the toolbar
will also appear if you view a page. This makes it easy to edit pages and then proof the results.

You can quickly view the “front end” of the website (what the visitors see) by hovering the cursor over the site name on
the menu (in the example below, Brunet Lab):

Edit 5ite

Tip: If you right-click the lab name or Visit Site and choose Open in New Window , you can have both the Dashboard and
the website open in separate windows. This makes it easier to make edits, then proof the results.

Blocks

The WordPress Administration screens contain blocks that provide information, change settings, or take action.
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Right Now Block

The Right Now box shows you statistics on your content, and the amount of storage space your site uses. If you are
running out of space, the Space Used statistic will appear in red.

Help Block

The Help box contains links to our documentation site and to email Russell Labs IT.

Pages

Pages make up the core of your Russell Labs WordPress site. Visitors access pages through the site menu, by using
search, or by clicking a link on a page.

Finding a Page to Edit

For sites with less than 20 pages... For sites with more than 20 pages...
1. On the Dashboard menu, click Pages. 1. Open your website in a browser.
The Pages screen appears, listing all the pages: 2. Use the site menu to open the page you want to
_ edit.

[E] Pages scanew e

A2 | Publshed Searen Pages 3. Click the Edit button in the content area of the

Bk Actons [ | sonly | | spowatgees[] | Fiter screen. The Edit Page screen opens.

[ Title Author W Date

m (D foslen i Tip: If you can’t find the page on the site menu, try using

O Publicstions ispalen i the Search box to search for the page.

WordPress lists the pages in alphabetical order by
page title.*

* if the list does not appear in alpha order, email
webeditor@russell.wisc.edu for a workaround.

2. Click the page title. The Edit Page screen opens.

Edit Page Screen

Overview

The Edit Page screen consists of a title box, a content editing box, and number of blocks to change settings and to save
the page:
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Edit Page AddNew

| Page updated. View page Title box

| Research

Permalink: http:/flabs russell wiscedu/brunet/researchs| Cdit View Page || Get Shartlink

h Add Media

Research Areas

1. Gene flow by distinct pollinators

2. Hybridizafion between native and invasive elm species

3. Transgene spread

4. Others

1. Gene flow by distinct
pollinators

Insects are important
pollinators for many fruit,
vegetable, forage, and oil-zeed
crops. Because many of these
crops are visited and pollinated
by wild pollinators, in addition

p

Visual = Text
File v Editv Insert~ View~ Formatw Tablew Tools»
B I &« =+ v £ = = B -
Paragraph v = = = B 0 QO = © Av @
&l

- Content editing box

Word count: 830 Last edited by dlang on May 15, 2014 at 2:15 pm

Screen Options Hzlp

Publish .

Preview Changes
¥ Status: Published Edit
@ Visibility: Public Edit
) Revizions: 7 Browss

f™ Published on:Jan 10, 2012 @ 19:23
Edit

-

Page Attributes .
Parent

(no parent)
Template

Default Template
Order

0

Meed help? Use the Help tab in the upper
right of your screen.

Blocks

Title

Enter a page title. Page titles:

e can contain punctuation

e can not contain formatting (e.g. italics) or symbols (e.g. &)

e must be unique

Content Editing Box

The content editing box has four parts:
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i F View

0 Add Media * Add media button visual || Test
tabs
File » Edit= Insert- View- Formate Table= Tools »
- = = . Formatting
B I & =+ =v E £ = B v = -
Toolbar

Paragraph =+ = %= £ 3¢ ﬂ ¢ 0 = 2 A~ 80

Research Areas
1. Gene flow by distinct pollinators

3. Tranzgene spread
4. Others
1.

p

Word count: 830

2. Hybridization between native and invazive elm species

Gene flow by distinct
pollinators
Insects are important

Last edited by dlang on May 15, 2014 at 215 pm

Content
area

Add Media Button

The Add Media button lets you insert images and link to files (e.g. PDF, Word, Excel).

View Tabs

Page Content Displayed in View Tab:

Same Content Displayed in Text Tab:

1. Gene flow by distinct
pollinators

Insects are important pollinators for
many fruit, vegetable, forage, and
oil-seed crops. Because many of
these crops are visited and
pollinated by wild pallinators, in
addition to managed pollinators, it is

important to consider the impact of

Use the View tab for editing your page.

Editing Toolbar

<p>Research Areas<br /»<a href="#gene_flow">1. Gene flow by distinct pollinators</a»<br /»<a
href="#hybridization"»2. Hybridization between native and invasive elm species</a»<br /»<a
href="#transgene">3. Transgene spread</a><br /»<a href="#others"»4. Others</ax<br /><a
name="gene_flow"></ax»<br /»<strong><img class="alignleft" alt=""
src="http://labs.russell.wisc.edu/brunet/files/2@12/81/bee_columbine.jpg" width="3@@"
height="225" />1. Gene flow by distinct pollinators</strong><br />Insects are important
pollinators for many fruit, vegetable, forage, and oil-seed crops. Because many of these crops
are visited and pollinated by wild pollinators, in addition to managed pollinators, it is
important to consider the impact of different pollinators on gene flow. This has become
especially important when considering the potential for transgene escape from genetically
modified crops. As a first step, we used the Rocky Mountain columbine (Aquilegia coerulea) to
establish that distinct pollinators differentially disperse pollen. ke showed that distinct
pollinators can differentially affect the outcrossing rate of plants (Brunet and Sweet,
Evolution, 2886) and, using genetic markers, that these different pollinators may
differentially move pollen long distances (Brunet and Holmguist, Molecular Ecology, 2089). In

The Text tab, designed for advanced users, looks “under the hood”
of WordPress and displays the page content in raw HTML.

The Editing Toolbar appears above the content box and contains a number of icons similar to Microsoft Word's icons.

Toolbar Icons

The toolbar icons resemble the icons in Microsoft Word. These icons are specific to WordPress and Web tasks:

-’ Changes to distraction-free writing mode - a stripped edit screen.
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Paste as plain text — removes formatting from other programs.

Removes text you have applied within WordPress.

H o m

Insert a table — tables behave differently in WordPress, contact webeditor@russell.wisc.edu
for help.
Styles menu — applies specific WordPress styles to highlighted text.

Paragraph =

Toolbar Toggle (a.k.a. “Kitchen Sink” — expands or collapses a second toolbar row.

=]
Keyboard Shortcuts
Undo Control+Z
Copy Control+C
Paste Control+V
Where’d My Icons Go?

The Editor toolbar has two settings: the default, which shows only one row of icons, and the full setting, which shows
two or more. If you see only one row, you can click the Toolbar Toggle icon (see above) to display the rest of the icons.

Adding More Icons

You can add more icons to the Editor toolbar by going to Settings..TinyMCE Advanced.
Please do NOT change the settings in the Advanced Options box or enable Link (replaces the Insert/Edit Link dialog) —
these settings have other repercussions (some of them nasty).

Editing a Page
Quick Steps to Edit a Page

From inside the WordPress Administration Screens:
1. Onthe Dashboard Menu, click Pages. The Pages screen appears.
2. Click the name of the Page. The Edit Page Screen appears.
From your site (as the visitors see it):
1. Click Edit.* The Edit Pages Screen appears.
* The Edit link only appears when you are logged into the WordPress Administration Screens.
2. Click in the content area and make desired changes.

3. Click Update.

Pasting Content from Word

1. In Word, select and copy text.
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2. InWordPress in the Edit Page screen, click in the content area.
3. Right-click and choose Paste from the popup menu.

4. Click Insert.

| Important: You can’t copy and paste images from Word — you will need to use the Add Media button.

Important Differences in Formatting Text on the Web
e The Web does not have tabs, hanging indents, or dot leaders.
e Text and objects are positioned proportionately to each other and can move — they are not fixed size or width.
e Text is not underlined for emphasis — underlining is saved for hyperlinks. Bold text for emphasis.
e [talics can be difficult to read on the screen.

e Contrast is very important in making text easy to read on a screen. Use black text against a white background,
and do not make text medium to light gray.

e Content will reflow according to display size, e.g. huge television screen, desktop computer monitor, tablet,
mobile phone.

o The same page will probably look somewhat different across various web browsers (e.g. Internet Explorer,
Firefox, Chrome, Safari).

Tip: Simple formatting provides the best results.
Inserting Single Images in the Content Area

NEVER UPLOAD PHOTOS TO OUR WORDPRESS SITES WITHOUT DOWNSIZING THEM FIRST!!

1. Go to Web Photo Resizer - http://www.webresizer.com — upload your image and resize it so the width is 585 or less
pixels wide. Click “download this image” and save the resized image to your hard drive.

2. In WordPress, click in the content area where you want the image to appear.

3. Click Add Media. The Insert Media screen appears.

4. Click Upload Files. Click Select Files.

5. Locate and select the files. The filename will include _opt. Click Open.

6. The Insert Media screen re-appears, showing the image information in the right panel.

Make sure you chose the optimized image, not the original — check the size — the first number should not be
greater than 585 pixels.

7. If you want to wrap text around the image, set the alignment of the image in the right panel through the Alignment
drop-down.

8. Click Insert Into Page.
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Inserting Multiple Images in the Content Area - Galleries and Simple
Slideshows

NEVER UPLOAD PHOTOS TO OUR WORDPRESS SITES WITHOUT DOWNSIZING THEM FIRST!!

1. Go to Web Photo Resizer - http://www.webresizer.com — upload your image and resize it so the width is 585 or less
pixels wide. Click “download this image” and save the resized image to your hard drive.

2. In WordPress, click in the content area where you want the image to appear.

3. Click Add Media. The Insert Media screen appears.

4. Click Create Gallery.

5. Click Upload Files. Click Select Files.

6. Locate and select the files. The filename will include _opt. Click Open.

7. The Insert Media screen re-appears, showing the image information in the right panel.

Make sure you chose the optimized image, not the original — check the size — the first number should not be
greater than 585.

8. Click Create a new gallery. The Edit Gallery screen appears.
9. Inthe left pane, if desired, drag-n-drop images to rearrange them.
10. In the right pane, choose the number of columns, and the type — Thumbnail Grid or Slideshow.

11. Click Insert Gallery.

Inserting Links to Files (PDF, Word, Excel) in the Content Area

1. Click Add Media.

2. Click Upload Files. Click Select Files.

3. Locate and select the files.

4. The Insert Media screen re-appears, showing the file information in the right panel.

5. Inthe right panel, enter the link text in the title box.

6. Click Insert Into Page.

“Embedding” - Linking to Images, Videos, and Audio Files Hosted
Elsewhere

WordPress can “embed” information from other providers and make it look like it’s housed inside your webpage. It can
do this with images, videos, and audio files. Those providers include YouTube, Flickr, Instagram, TED, Twitter and more.
To see the full list of files WordPress can embed, visit this webpage: http://codex.wordpress.org/Embeds

We do not host videos here at Russell Labs, but we can upload them to our shared area at Vimeo.com. If you have a
video you’d like us to upload, email webeditor@russell.wisc.edu and we’ll contact you.
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Making a Page “Invisible” While Editing
By default, all pages in your site are visible.
Visitors can find a page through search results on the site, or through search engines.
To prevent premature content release:
e Do not add pages to the site menu until you’re ready for visitors to view the pages.

e Set page visibility to Private while you are editing the page.

Revisions - Reverting a Page to a Prior Version

WordPress stores a copy of your page each time you click Update. WordPress also “autosaves” the page in case of a
power failure or a network interruption.

You can compare prior versions of a page to the current version, and revert the page back to a prior version.

1. Inthe upper-right corner of the screen, click Screen Options. Click the Revisions checkbox. Click Screen Options
again.

2. Scroll down the page and locate the Screen Revisions box:

Revisions

brunet, 3 months ago (6 May. 2013 @ 15:11:12)

jmhenss, 3 months ago (6 May. 2013 @& 15:11:05) [Autosave]
jmhenss, 3 months ago (6 May. 2013 (@ 15:10:30)

jmhenss, 3 months ago (6 May. 2013 (@ 15:03:46)

3. Click a link to display the Compare Revisions Screen:

i P i . . n =L
s Compare Revisions of “Publications

[] Compare any two revisions

Previous ar Next

Current Revision by brunet
3 months ago (6 May @ 15:11)

Restore This Revision

Title

Publications Publications

4. Drag the circle on the timeline slider left. The screen changes to show the different versions side by side, with the
changes highlighted in color:
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s Compare Revisions of “Publications”

Previous

Autosave by jmhenss
3 months ago (6 May @ 15:11)

Title
Publications
Content

<p style="text-align: left” align="center”»<span style="color:
#4h@B82"><span style="font-size:
small"»<strong>l</strong></span><strong><span style="font-zize:
small”>ochanne Brunet, Juan Zalapa, Francesco Pecori and
Alberto Santini. 2813. Hybridization and introgression between
the exotic Siberian elm, <i»>Ulmus pumila</i>, and the native
Field elm, <i>U. minor</i>, in Italy. <em>Biological
Invasions</em> (<em:in press</em:).<fspan? </strong></span></p>

Help
[] Compare any two revisions

4k MNext

Restore This Autosave

Publications

<p style="text-align: left” align="center"><span style="color:
#1bB@82 ;font-size: small"><strong»l</strong><strongrohanne
Brunet, Juan Zalapa, Francesco Pecori and Alberto Santini.
2013. Hybridization and introgression between the exotic
Siberian elm, <i>Ulmus pumila</i>, and the native Field elm,
<i»J. minor</i>, in Italy. <em>Biological Invasions</em>
(<em>»in press</em>). </strong></span></p>

5. To restore this revision, click the blue Restore button in the upper right corner.

Managing Your Site Menu

Adding a Page to the Site Menu

1.

2.

3.

On the Dashboard menu, locate and click Appearance. Choose Menus from the popup menu.

The Edit Menus page appears:

Edit Menus

Edit your menu below, or create a new menu.

Pages Menu Name  Menu 1

Menu Structure
Most Recent | View Al Search

Drag each item into the order you prefer. Click the arrow on the right of the item to reveal additional configuration

[] Publications oplions.
[[] Pecple
[[] Research Welcome Page
[] welcome
People Page
Select Al Add to Menu
Publications Page

Screen Options Help

In the Page box, click the checkbox next to the page you just created.

4. Click Add to Menu. A menu entry named after the page appears in the Menu box in the right column.

5. Click Save Menu.
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Removing a Page from the Site Menu

When you delete a page, the page menu entry remains. You will need to edit the menu and remove the entry.
1. On the Dashboard menu, locate and click Appearance. Choose Menus from the popup menu.
2. The Edit Menus page appears.

3. Inthe right block, click the down-pointing arrow for the page:

Our Sites Page

The block expands:

Our Sites

Navigation Label Title Aftribute
Our Sites

Move Up one Downone Under Limits To the top

Original: Qur Sites

Remove | Cancel
4. Click Remove. The page menu entry disappears.
5. Click Save Menu.

To learn more about menus, including how to design multi-level menus, see the handout How to Maintain Your Site
Menu on our WordPress documentation page.

Changing the Appearance of Your Website

Header Images

Most Russell Labs WordPress sites have the ability to display a single image or a series of rotating images to the top of all
pages in the site. These images are called header images.

We set the header images for your site at the time we create it. If you would like the header images changed, please
email webeditor@russell.wisc.edu.

Matching the Header Image to the Page Topic

Header images are set for the entire site, but can be overriden on a specific page. This is useful when you want the
page’s header image to relate to the page topic. For example, on a page about owls, you could set the header image to
an owl photo.

For details, see the handout How to Match the Header Image to the Page Topic on our WordPress documentation page.
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Adding an Advanced Slideshow

You can create and insert image slideshows into the content area of a page using the RoyalSlider plugin. Slides may
contain images, captions, and even embedded YouTube videos.

For more information, email webeditor@russell.wisc.edu.

Customizing Site Colors

On some Russell Labs WordPress sites, you can customize your site colors.

For details, see the handout How to Customize Site Colors on our WordPress documentation page.

Note: If you want to set a background image for your entire site, please email webeditor@russell.wisc.edu.

Changing the Layout of a Page

Templates
WordPress uses templates to control the look and feel of your site.

Templates control areas such as the default font and colors of your site, and which areas you can edit:

s the text in the header.

You ean change

the text in the body.

This is the text that appears
in the Edit page screen.

You cannot change
the text in the footer

You can choose a different template for a page to change how the page looks. Template choice varies by site, but these
are the most common page templates:
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Banner Banner Banner
Menu Menu Menu
page title page title
%
o
Content Content Content %
Footer Footer Footer
Default template — content is Showcase template — content is Sidebar template — content is
centered, with wide right and left centered, with smaller right and left shifted to the left, with a wide right
margins. margins. There is no page title, so you | margin. The wide right margin
will need to add one at the top of the | contains a sidebar.
content box.

Sidebars

A sidebar appears on a page when you choose Sidebar template on the Edit Page screen.

Sidebars can be located on the left or right side of the page site-wide; if you want to switch the side, email
webeditor@russell.wisc.edu.

A sidebar can contain widgets - text blocks, calendars, links, and imported content from other websites (called RSS
feeds). For a great example of sidebar content, see the PDDC website - http://labs.russell.wisc.edu/pddc/

Adding Sidebar Content

Sidebar content is not controlled by the Edit Page screen. To add, edit, or delete sidebar content, from the Dashboard
menu click Appearances..Widgets. The Widgets screen appears.

For details, see the handout Widgets on our WordPress documentation page.

Adding Additional Features to Your Website

Forms

We can create forms and add them to your website. The forms can be used for contacting you, event registration, data
entry for a field research project, or other simple data gathering.

The form software can email the data to multiple email addresses, and save a copy inside your website. It can also email
the form submitter with a thank you and further instructions.

For more information, email webeditor@russell.wisc.edu.

Google Calendar

If you currently use Google calendar to keep track of your events, you can add a calendar with those events to your site’s
sidebar.
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For details, see the handout How to Add a Google Calendar to Your Site’s Sidebar on our WordPress documentation
page.

Tracking Site Visitors

After you launch your site, you may want to understand:
o who is visiting your site
e how they found it (links from email, Facebook, search engines, etc.
e which are the most popular pages

This information is called web analytics.

Our JetPack plugin shows you summary information right inside WordPress:

Site Stats
200
150
100
50
o

Ju26  JulZE Jul30 Augt Aug 2 AugS  AugT
View All

Top Posts Top Searches

Sample Collection and Submission

F;c.t Sizéet Listing

Genera\ .Sampu’e Collection
éma; 0:8 August — Evenis
;ink; .

ija'le.lil.i:r.ag.a Sample in Wisconsin

Clinic Staff

JetPack can also display more complex information.

Installing JetPack on Your Site

1. Email webeditor@russell.wisc.edu and ask to have the plugin turned on.

2. Following the instructions in handout How to Setup JetPack on our WordPress documentation page.
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